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CHEAM CAMERA CLUB  

 COMPETITION RULES  
  __________________________________________  

  
A  EXTERNAL COMPETITIONS  
  

1 The Club shall enter such external competitions as it regards as appropriate to 
publicise the expertise of its members.  

2 In order that the Club can compete effectively, members are asked to make 
available their best work. 

3 Selection of entries shall be by a Selection Committee of Club members elected at 
the Annual General Meeting (see part C on page 8 below).  The criterion for 
selection shall be to win. 

4 Any member who is not elected to the Selection Committee may attend selection 
sessions as a silent observer. 

5 The Selection Committee shall publish dates and requirements for all competitions 
as far in advance as possible.  Monthly reminders shall be given at weekly 
meetings.  

 
B  INTERNAL COMPETITIONS  
  
Internal competitions are open only to current members of the Club, and shall consist 
of the following categories:  
  
1 Endeavour Cup—six projected digital images (PDIs) as a group  
2 Ladies v Gents PDIs (subject to programme)  
3 Set subject —PDIs and colour or monochrome (mono) prints (subject to 

programme)  
4 Monochrome prints  
5 Monochrome Print of the Year (Photographer of the Year—mono print)  
6 Colour prints  
7 Colour Print of the Year (Photographer of the Year—colour print)  
8 PDIs  
9 PDI of the Year (Photographer of the Year—PDI)   
10 Exhibition competitions—print panel, single mono or colour print, and single PDI.  
  
Before competing for the first time in any category of images, a member may be 
required to submit six images (no more than five years old) in the relevant category or 
categories to the Selection Committee, who will decide which group(s) the member 
may compete in.  
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1 Endeavour Cup—PDIs  
  
1 Best collection of six PDIs per entrant, shown as a group, illustrating a theme of 

the entrant’s own choice.  
2 The images must be submitted with an overall title. Individual images should not 

be titled.  
3 There will be no segregation of groups for this competition.  
4 Images must not have been entered in this competition previously. 5 To be judged 

by an independent judge (not a Club member).   
  
2 Ladies v Gents—PDI Competition  
  
1 A competition to be held at the Programme Secretary’s discretion.  
2 The competition may be held as a normal PDI competition or as a Match-anImage 

competition.  
3 A Captain will be appointed for each side and will be responsible for submitting 

that side’s entry.  
4 The two Captains shall agree a suitable number of entries per side and the 

maximum number of entries by any author.  
5 The Captains shall ensure that any member submitting work for this event shall be 

represented by at least one entry provided the entry is received by the Captain’s 
deadline.   

6 Neither side’s entry shall include more than four images by the same author unless 
the Captains have agreed otherwise, after taking into account the numerical 
balance of ladies and gents.  

7 To be judged by an independent judge (not a Club member).  
  
3 Set subject—PDIs and Prints  
  
1 Two ‘set subject’ competitions may be held each season.   
2 One will be for PDIs and one will be for colour or mono prints.  Up to two entries 

per author will be allowed per competition.   
3 There will be no segregation of groups.   
4 The subjects will be selected by the Programme Committee.   
5 To be judged by an independent judge (not a Club member) who will select one 

winner from each competition.  
 
4 Monochrome (mono) print competitions   
  
1 There will be three groups—Advanced, Intermediate and Standard.  
2 The number of internal mono print competitions for each season will be FOUR, 

but may be changed at the discretion of the Club Committee, which will inform 
the membership in advance   

3 Each member will be allowed to enter up to TWO mono prints in each internal 
competition.  Prints entered in the Advanced or Intermediate group must be 
mounted on a mount measuring 50cm × 40cm.  Members submitting prints for 
competition are asked, if possible, to send a PDI of each print at the same time to 
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the internal print competition co-ordinator to help the Selection Committee’s later 
consideration when compiling the Club’s entries to external competitions.    

4 No print or near duplicate may be entered more than TWICE or after receiving a 
mark of 9 or more in any season.  

5 Marks to be awarded are from 1 to 10 for each entry.  Half marks will be allowed.   
There will be no limit on the number of 10s awarded.    

6 A mono print is a black and white image or one that has been modified by the 
addition of a single tone to the entire image.   Trade processed entries are allowed 
and general colour adjustment is permitted.  However, no image manipulation by 
the trade processor or another third party is permitted.  

6a. The prime image content for a print, should be captured “photographically” and 
may be recorded on any sensor, film or sensitised material. The image, and all 
substantive image elements within it, must be the work of the photographer. 
Wholly or substantially computer-generated images are not permitted. Technical 
manipulation to enhance the image and produce the final print is permitted. All 
types of creative in-camera and post-production editing and manipulation by the 
photographer digitally or otherwise is allowed. This includes panoramic stitching, 
HDR, filters, multiple images or layers, artwork and computer graphics, as long as 
the original photographic content predominates and is entirely the work  of the 
photographer. No third party clip-art images, textures, or overlays are permitted.   

7 All new members shall, unless the Selection Committee otherwise decides (see 
below), be placed in the Standard group.  Any member who wishes to be 
considered for a higher group in the internal competitions may, at the beginning of 
the season, or on joining, submit to the Selection Committee a panel of six recent 
prints (no more than five years old).  That Committee will then decide whether the 
member should be moved to a higher group.  Members taking part in their first 
season of competition should not expect to be allocated immediately in the 
Advanced group.  

8 Any member who has not entered these competitions for three years or more and 
who wishes to re-enter may be required to submit a panel of six recent prints (no 
more than five years old) to the Selection Committee for consideration at the 
beginning of the season.  That Committee will then decide the appropriate group 
placing.  

9 To be judged by an independent judge (not a Club member).  
 
5 Monochrome Print of the Year—part of the Photographer of the Year 

Competition  
  
1 This competition will be held annually, following the completion of all internal 

competitions and will be held in conjunction with colour prints and PDIs.  
2 It will be open to mono prints that have received a mark of 9 or more during the 

season’s internal competitions.  
3 There will be a limit of TWO mono prints per member.  
4 There will be NO segregation of groups in this competition.  
5 To be judged by an independent judge (not a Club member).  
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6 Colour print competitions  
  
1 There will be three groups—Advanced, Intermediate and Standard.   
2 The number of internal colour print competitions for each season will be FOUR, 

but may be changed at the discretion of the Club Committee, which will inform 
the membership in advance.  

3 Each member will be allowed to enter up to TWO colour prints in each internal 
competition.  Prints entered in the Advanced or Intermediate group must be 
mounted on a mount measuring 50cm × 40cm.  Members submitting prints for 
competition are asked, if possible, to send a PDI of each print at the same time to 
the internal print competition co-ordinator to help the Selection Committee’s later 
consideration when compiling the Club’s entries to external competitions.  

4 No print or near duplicate may be entered more than TWICE or after receiving a 
mark of 9 or more in any season.  

5 Marks to be awarded are from 1 to 10 for each entry.  Half marks will be allowed.   
There will be no limit on the number of 10s awarded.    

6 Trade processed entries are allowed, with general colour adjustment if applied.  
However, no image manipulation by the trade processor or another third party is 
permitted.  

6a. The prime image content for a print, should be captured “photographically” and 
may be recorded on any sensor, film or sensitised material. The image, and all 
substantive image elements within it, must be the work of the photographer. 
Wholly or substantially computer-generated images are not permitted. Technical 
manipulation to enhance the image and produce the final print is permitted. All 
types of creative in-camera and post-production editing and manipulation by the 
photographer digitally or otherwise is allowed. This includes panoramic stitching, 
HDR, filters, multiple images or layers, artwork and computer graphics, as long as 
the original photographic content predominates and is entirely the work  of the 
photographer. No third party clip-art images, textures, or overlays are permitted.   

7 All new members shall, unless the Selection Committee otherwise decides, be 
placed in the Standard group.  Any member who wishes to be considered for a 
higher group in the internal competitions may, at the beginning of the season, or 
on joining, submit to the Selection Committee for consideration a panel of six 
recent prints (no more than five years old).  That Committee will then decide 
whether the member should be moved to a higher group.  Members taking part in 
their first season of competition should not expect to be allocated immediately in 
the Advanced group.   

8 Any member who has not entered these competitions for three years or more and 
who wishes to re-enter may be required to submit a panel of six recent prints (no 
more than five years old) to the Selection Committee for consideration at the 
beginning of the season.  That Committee will then decide the appropriate group 
placing.  

9 To be judged by an independent judge (not a Club member).  
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7 Colour Print of the Year—part of the Photographer of the Year 
Competition  

  
1 This competition will be held annually, following the completion of all internal 

competitions and will be held in conjunction with mono prints and PDIs.  
2 It will be open to colour prints that have received a mark of 9 or more during the 

season’s internal competitions.  
3 There will be a limit of TWO colour prints per member.  
4 There will be NO segregation of groups in this competition.  
5 To be judged by an independent judge (not a Club member).  
 
8 PDI competitions  
  
1 There will be three groups, Advanced, Intermediate and Standard.    
2 The number of internal PDI competitions for each season will be SIX, but may be 

changed at the discretion of the Club Committee, which will inform the 
membership in advance.   

3 Each member will be allowed to enter up to TWO digital images in each internal 
competition.  

4 No digital image or near duplicate may be entered more than TWICE or after 
receiving a mark of 9 or more in any season.  

5 Marks are to be awarded from 1 to 10 for each entry.  Half marks will be allowed.   
There will be no limit on the number of 10s awarded.   

6 Trade processed entries are allowed with general colour adjustment applied.  
However, no other image manipulation by the trade processor or another third 
party is permitted.  

7 All new members shall, unless the Selection Committee otherwise decides, be 
placed in the Standard group.  Any member who wishes to be considered for a 
higher group in the internal competitions may, at the beginning of the season, or 
on joining, submit to the Selection Committee for consideration a panel of six 
recent images (no more than five years old).  That Committee will then decide 
whether the member should be moved to a higher group.  

8 Any member who has not entered these competitions for three years or more and 
who wishes to re-enter may be required to submit a panel of six recent images (no 
more than three years old) to the Selection Committee for consideration at the 
beginning of the season.  That Committee will then decide the appropriate group 
placing.    

9 All images submitted are to be in JPEG format, set to Quality 10 or 12 (if using 
Photoshop or Photoshop Elements) or 100 (if using Lightroom).  

10 All images must be a suitable size for projection.  This means they must not 
exceed 1600 pixels in width and 1200 pixels in height.  For clarification some 
example sizes are included here:  

A ‘portrait’ format image is taller than it is wide, therefore the 1200 pixel 
height is the main dimension to consider.  
A ‘landscape’ format image is wider than it is high, therefore the 1600 pixel 
width is the main dimension to consider.  However, be careful, because a 
‘landscape’ image of 1600 high × 1200 wide would not be allowed.  In this 



 6  

case you would need to limit the height to 1200, and the width would be 
reduced pro rata.  
A ‘square’ image is limited by the maximum height.  Hence, a ‘square’ image 
would need to be a maximum size of 1200 × 1200.  

11 Images submitted may be either in monochrome or in colour.  
12 Images may be submitted on compact disc or USB memory stick or by email.  The 

media must not contain any images other than those being submitted for the 
competition.  All media submitted must be clearly labelled to identify the entrant’s 
name.  All media will be available for collection on the night of the competition.  

13 Images may be submitted with or without manipulation.  Only originals that were 
taken by the entrant using the photographic process are permitted.  In the case of 
combined images, every individual image must have been taken by the entrant.  
14 Entirely or substantially computer-generated images are not permitted.  

15 Images may be captured either by digital camera (including smartphones) or by 
scanning from the entrant’s original negative, slide or print.   

16 Laboratory scanning is permitted providing the original image was a negative, 
slide or print that was the work of the entrant.  

17 To be judged by an independent judge (not a Club member). All types of creative 
in-camera and post-production editing and manipulation are allowed. This 
includes panoramic stitching, HDR, filters, multiple images or layers, artwork and 
computer graphics, as long as the original photographic content predominates and 
is entirely the work of the photographer. No third party clip-art images, textures or 
overlays are permitted.  

18 The file structure and naming convention of all images submitted must conform to 
DiCentra software and the Club’s requirements (see Appendix B).  

19 All images submitted will be retained on the Club’s laptop, in case they are 
required for submission into an external competition.  Any members who do not 
wish to have their images considered for external competitions should tell the 
Digital Team Leader when submitting their images.  The Digital Team Leader 
will be responsible for informing the Selection Committee.  

20 No image may be altered in any way by the Club without the permission of the 
author.   

21 Guidance on the preparation of PDIs for internal competition is set out in 
Appendix B.  

  
PLEASE NOTE with regard to entering the same image in more than one in 
competition, a motion was passed at the AGM on 23/05/2018 as follows:  
  

1. In each season there are 3 internal competitions each with several rounds, 
colour print, mono print and PDI.  

2. If an image scores 9 or more in a competition, then it cannot be entered into 
another competition format in the same season unless it is significantly 
changed.  

3. It can be entered into one other format in a different season.  
4. If an image scores 8.5 or below, it may be entered once more in that format 

but also in the other formats unless it scores 9 or above when the above rule 
applies.  
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9 PDI of the Year—part of the Photographer of the Year Competition  
  
1 This competition will be held annually, following the completion of all internal 

competitions, and will be held in conjunction with mono prints and colour prints.  
2 It will be open to PDIs that have received a mark of 9 or more during the season’s 

internal competitions.  
3 There will be a limit of TWO images per member.  
4 There will be NO segregation of groups in this competition.  
5 To be judged by an independent judge (not a Club member).  
 
10 Exhibition Competitions   
  
1 All entrants must complete an entry form and follow the guidelines that are 

published by the Exhibition Organiser two/three months before the annual 
exhibition.  The guidelines may vary from year to year.  

2 There will be an award for the following categories exhibited:  
• Best Panel (three prints)    
• Best Colour Print • Best Mono Print  
• Best PDI.  

3 Certificates will be awarded for 2nd and 3rd in each category.    
4 All prints are to be mounted on 40cm × 50cm mounts and framed in either black 

or aluminium frames to the Club’s specification.  
5 All prints that have been selected by the judge as winners or receive an 

honourable mention may be shown as PDIs.  
6 For this purpose, all entrants submitting images for the exhibition may be required 

to submit digital files of their images, for showing on the Private Viewing Night, 
should they be selected by the judge.  

7 Exhibition competitions are to be judged by an independent judge (not a member 
of the Club).  

8 In addition, members of the public visiting the exhibition may be invited to vote 
for their favourite individual print, print panel and PDI.  The winner in each 
category will receive an award.  

  
11 Membership of competition groups  
  
Print groups  
1 In accordance with decisions taken at the Annual General Meeting in May 2014, 

from 2015 onwards the winner of each of the Intermediate and Standard print 
groups will be promoted to the Advanced and Intermediate groups respectively for 
the next season.  Any member of the Intermediate groups whose aggregate score 
is within 4 points of the group winner will also be promoted.    

2 A member of a prints Advanced group who has not achieved a benchmark score 
(currently set at 8) will be moved to the Intermediate group for the next season.  
Members’ scores will be calculated as follows: if a member has submitted eight 
entries the two lowest scores are disregarded; if a member has submitted seven 
entries the single lowest score is disregarded; otherwise, if a member has 
submitted fewer than eight entries each non-entry is scored as zero.  Thus in all 
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cases the member’s six highest scores are aggregated and divided by 6 to give the 
performance against the benchmark of 8.  

  
For example, a member who enters two prints for two of the four rounds in a 
competition plus one entry in the third round will have entered a total of five 
prints, instead of a possible maximum of eight.  The balance of three 
nonentries are each scored as zero and added to the scores for the five entries 
and the total is divided by six.  A member who scored 8 for each of the five 
scoring entries will therefore achieve an average of 40 ÷ 6 = 6.7 against the 
benchmark of 8.  

  
3 The benchmark of 8 will be kept under review and may be changed by the Club 

Committee, normally with at least one season’s notice.  A change might become 
appropriate if, for example, judges adopt a practice of awarding scores over a 
wider numerical range than at present.  

4 As agreed at the 2019 AGM, any member who achieves the status of Advanced in 
either of the club print competitions (colour or mono) can only be relegated to the 
Intermediate Group and never to the Standard Group. 

5 For members of a prints Intermediate group, the required benchmark score is 6.  
Thus a member of an Intermediate group who has not achieved a benchmark score 
of 6 will be moved to the Standard group for the next season.  Members’ scores 
will be calculated in the same way as described in paragraph 2 above.  Thus in all 
cases the member’s six highest scores are aggregated and divided by six to give 
the performance achieved against the benchmark score of 6.    

  
PDI groups  

6 Following the decision taken at the Annual General Meeting in May 2016, 
from 2017 onwards the winners of the PDI Intermediate and Standard groups will 
be promoted to the Advanced and Intermediate groups respectively for the 
following season.  

7 As agreed at the 2019 AGM, any member who achieves the status of Advanced in 
the club PDI competition can only be relegated to the Intermediate Group and 
never to the Standard Group. 

  
Balance between the groups  
8 The Club Committee will keep under review the size of the three competition 

groups for each of the three formats.  After taking account of changes in 
membership at the end of the season the Club Committee may, at its discretion 
and in order to maintain a reasonable balance between the groups, promote 
additional members to the next higher group.  Such members will normally be 
selected according to their aggregate scores in the past season.  

  
12 Submitting entries for internal competitions  
  
1 Print Competition entries will not be accepted after 7.50pm on the evening of 

the competition; titles should be handed to the internal print competition 
coordinator the previous week or telephoned on or before the Tuesday before the 
competition.    
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2 PDI Competition entries should be submitted by email by 10.00pm on the 
Monday before the competition (or such earlier deadline as the Digital Team 
Leader may announce).  
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C  THE SELECTION COMMITTEE  
  
1 The Selection Committee shall consist of three executive members elected at each 

season’s AGM.  In addition there shall be two reserve members also elected at the 
AGM, who shall deputise for any absent executive members.  Unless elected the 
Club’s SPA Representative and FSLPS Representative may attend but not vote at 
meetings of the Selection Committee.    

2 The duties of the Selection Committee shall be:  
(a) to select the Club’s entries for external competitions.  
(b) to oversee the management of the Club’s entries for external competitions.  
(c) to determine whether a new member should be assigned to a higher group 

instead of the Standard group.  
(d) to resolve any dispute by a member over the group to which that member has 

been assigned or moved at the end of a season.  
3 In the unavoidable absence of a Selection Committee executive member and any 

reserve member that Committee shall co-opt a replacement if time permits.  
4 Any Club member who is not elected to the Selection Committee may attend 

selection sessions as a silent observer.    
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CLUB TROPHIES  

  
President’s Cup:  Winner: Advanced Group colour prints 
Vice Presidents’ Cup Winner: Intermediate Group colour prints  
Chairman’s Cup:   Winner: Standard Group colour prints  

Cup:  Winner: Advanced Group mono prints  

Cup:  Winner: Intermediate Group mono prints  

Cup:  Winner: Standard Group mono prints  

Glass pillar:    Winner: Advanced Group PDIs  

Glass pillar    Winner: Intermediate Group PDIs  

Glass pillar:    Winner: Standard Group PDIs  

Roland Halle Cup:   Winner: Colour Print of the Year  

Cup:  Winner: Mono Print of the Year  

Millennium Cup:  Winner: PDI of the Year  

Silver Salver:   Winner: Best Colour Print in Exhibition  

Silver Salver:   Winner: Best Mono Print in Exhibition  

Cup:  Winner: Best Print Panel in Exhibition   

Cup:  Winner: Best PDI in Exhibition  

Cup:  Winner: Individual Print with highest popular vote at the 
annual exhibition  

Glass pillar:   Winner: Print Panel with highest popular vote at the annual 
exhibition  

Trophy  Winner: PDI with highest popular vote at the annual 
exhibition  

Endeavour Cup:  Winner: Six PDIs on a theme shown as a group  

Tom Bothwell   Awarded to the member combining enthusiasm  

Memorial Trophy:   with service to the Club  

Susan Hill Award  Awarded to a member of not more than two full seasons in 
recognition of that member’s progress as a photographer 
and contribution to the life of the Club. 

—————————————————————————————  
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Appendix A  
  

Example of rules for a Match-an-Image competition for three teams  
(the rules may be varied, for example to accommodate only two 

teams or more than three teams)  
  
* Each team brings along a pre-selected set of 60 PDIs (JPEGs in sRGB colour 

space fitting in 1600 × 1200 pixels).  

* The evening consists of 51 rounds (26 before the tea break, 25 afterwards).  

* The home team starts followed by the others in alphabetical order.  

* In each round one team presents an image from its bank (using its own projector 
and screen).  

* Thus each team will present first 17 times, rotating with the other teams.  

* The other teams have 30 seconds to respond with an image from their image 
banks.  

* Images can be used only once; therefore each team will use 51 of its 60 images.  

* Points will be awarded as follows:  

* The team that presents an image first automatically gets 1 point.  

* 1 point is gained for an image judged to match the image first presented. A 
match can be on colour, shape, pattern or subject.  

* 1 point is gained for the PDI judged to be the best of the three in each round, 
excluding any non-matching images.  

* The most any team can score per round is 2 points.  

* The winning team is the one with the most points.  
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Appendix B  
  

Preparation of PDIs for internal competition  
  

Image submissions  
  
Images may be submitted by email to the Digital Team leader.  
  
Whatever imaging software you use the PDI files must be submitted as follows:  
  
Up to TWO images may be entered.  Images must be in JPEG format and contained in a folder 
that is titled with your first and last names, for example:  
c:\temp\joe soap\  
  
The image titles must start with a sequence number (containing three digits as exampled 
below) followed by a space then the image title. They should therefore look like this: 

001 A foggy day in London  
002 A sunny day in London  
(note: do not include your name in the title of image files)  

  
Image preparation when using Adobe Photoshop CS2/3/4/5  
  
To prepare your images to the correct size for projection on the Club’s computer, which uses 
DiCentra software, follow the process below.   
  

• Open Photoshop and edit your image as required. When editing is completed, and 
with the image still open, flatten any layers.   

• Go to >File>Automate>Fit image, and type in 1600 pixels for the width and 1200 
pixels for the height.  

• Go to >Image>Mode>Convert to profile and convert the image to sRGB working 
space.   

• Create a folder which must be titled using your entrant’s name.  Save your images (up 
to two permitted) into this folder.  

  
The image titles must start with a sequence number (containing 3 digits as exampled below) 
followed a space then the image title. They should therefore look like this:    

001 A foggy day in London  
002 A sunny day in London  

  
To save to a new file: go to FILE>SAVE AS to save the image to the required file name in 
JPEG format with a quality setting of 10 or 12.  
  
Image preparation when using Adobe Photoshop Lightroom  
  
There is no is ‘save’ command in Lightroom, so in order to get your image to the size 
required for competition (1600 pixels × 1200 pixels) you should edit your image and, 
when editing is completed, export your image to your hard drive.  
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Go to >File>Export.  This opens a window with nine headings or windows.  You will 
need only four of these windows, namely Export Location, File Naming, File Settings 
and Image Sizing.  
Go to Export Location: where it says Export To: select ‘Specific Folder’, then select 
‘Choose’—this will open the Finder window on a Mac and the Explorer window on 
Windows.  
  
You may prefer to export to the desktop at this point and file away later, select  
Choose/Open in the Finder or Explorer window, this then takes you back to the 
Export window.  Where it says Existing Files select ‘Choose a new name for the 
exported file’.  
  
Now move onto the File Naming window: tick ‘Rename To’ and select ‘Custom 
Name’.  At ‘Custom Text’ type in your image file name, such as  ‘001 A foggy 
day in London’.  
  
Now move onto the File Settings window: in ‘Image Format’ select ‘JPEG’ and at 
‘Colour Space’ select ‘sRGB’.  Quality should be set to 100.  ‘Limit file size’ should 
be UNTICKED.  
  
Now move onto the final window Image Sizing: tick ‘Resize to Fit’ and select ‘Width 
& Height’, at W: 1600 at H: 1200, select pixels and set resolution to 300 pixels per 
inch.  Now select ‘Export’.  Your image will now appear on your desktop ready sized 
for emailing or saving to media.  
  
Image Preparation when using Adobe Photoshop Elements  
  
1 Open an image.  
2 Duplicate the image (IMAGE/DUPLICATE).  
3 Close the original image.  
4 Flatten all layers (LAYERS/FLATTEN IMAGE).  
5 Resize the image.  There are two ways to do this: Quick resize image: 

FILE/AUTOMATE/FIT IMAGE  
Constrain using 1600 pixels by 1200 
OK.  
Alternative image resize: IMAGE/Image Size  
Tick ‘Constrain proportions’  
Tick ‘Bicubic’  
Type in 1600 pixels in the box with the largest number of 
pixels Resolution 72 DPI OK.  

6 Set/convert colour profile to ‘sRGB’.  
Always CONVERT to profile (‘ASSIGN PROFILE’ leads to unexpected 
results).  
EDIT/CONVERT TO PROFILE  
Destination space (drop down menu, choose ‘sRGB’).  

7 Save your file(s)—  



 15  

File naming should take the form of a sequence number (containing three 
digits as exampled below) followed by a space then the image title, for 
example:  

001 The red robin  
002 Sunlight at dawn  

(note: do not include your name in the title of image files)  
If you are submitting via CD or USB please create a named folder using your 
first and last names, for example: c:\temp\tom cooker\  
Then save your numbered images files inside this folder:  
FILE /SAVE AS using the following settings  
Image Options/Quality/12 (maximum)  
Format Options/Tick ‘Baseline Standard’  

  
If emailing remember to ensure the images are sent Actual Size  
  

  
  
  
  

Revision Date: 23rd May 2019 
www.cheamcameraclub.co.uk    

 


